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Introduction
INTRODUCTION
The CCS-PRO* series of switches are focussed upon allowing you to 
seamlessly access multiple computers and their display screens, using common 
peripherals. 
CCS-PRO switches allow you to use a single USB keyboard and USB mouse 
to fulfil functions that previously required four or eight separate sets. This 
provides immediate savings in both desk space and also the time required to 
access and control systems and screens. The CCS-PRO4 supports up to four 
connected systems while the larger CCS-PRO8 allows up to eight systems to 
be accessed.
CCS-PRO switches feature our True Emulation technology, which ensures that 
the full characteristics of the connected USB keyboard and mouse are passed 
to every system. 
In addition to switching the keyboard and mouse, the CCS-PRO switches can 
also share a set of speakers and two separate USB peripherals between the 
various systems. This can be done either in concert with the keyboard and 
mouse (and each other) or totally independently.
CCS-PRO switches can be used in combination with various Adder extender 
products (such as AdderLink Infinity, X50 and X-DVIPRO) to extend the 
distance between the user and the computers under control.  
Switching between the systems connected to the CCS-PRO switches can be 
achieved in six different ways:
•	 The innovative Free-Flow automatic switching utility, 
•	 The COMPUTER button on the front panel,
•	 Keyboard hotkey combinations,
•	 Mouse button combinations,
•	 Remote control via an external system,
•	 The optional remote control selector.	       

Where additional feedback is required as to which systems and screens are 
selected at any time, the optional CCS-XB kit provides discreet stick-on LED 
monitor indicators. When a system/screen is selected, a corresponding LED 
monitor indicator illuminates (in a choice of colours) to confirm the action.

The optional USB Clipboard application can be used to allow text to be 
copied and pasted between any of the connected systems. A special utility 
program (and Microsoft .NET v4.0 or above) must be pre-installed on each 
computer that requires use of the cut and paste facility. 

Free-Flow
An innovative in-built utility that allows the unit 
to automatically switch between channels by 
monitoring the mouse pointer position. 

The keyboard/mouse, the speakers and two individual 
USB channels can be collectively or separately 

switched through to each PC system using a variety 
of manual and/or automatic switching methods.

The CCS-PRO8 is depicted here with its maximum 
of eight computers and screen. CCS-PRO4 models 

support up to four computers and screens.   

Internal
network

Remote
configuration
and control

www.adder.com

* References to CCS-PRO apply equally to both 
the CCS-PRO4 and CCS-PRO8 products.
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WHAT IS FREE-FLOW?
Adder Free-Flow delivers an innovation in K/M switching. Using Free-Flow you can 
automatically switch between target computers simply by moving the mouse pointer 
from screen to screen. 
Adder Free-Flow resides on the CCS-PRO switch itself, sensing screen boundaries and 
instantaneously switching keyboard and mouse (and related peripherals) to the defined 
target computer. Free-Flow can be configured for almost any combination of screens, 
which allows you to declare the individual screen sizes and visually position each one 
relative to the others.
Free-Flow consists of special code within the CCS-PRO switch plus an intuitive graphical 
configuration application. First you inform the Free-Flow configuration application how 
many screens you have, their pixel resolutions and how they are physically arranged (e.g 
side-by-side, vertical stack, square formation, etc.). You then download this information to 
the CCS-PRO switch and this is used during operation to determine the precise moment 
to switch from one screen/system to the next.
The beauty of Free-Flow is its simplicity of configuration and operation. Once the initial 
configuration has taken place, all monitoring and switching is handled within the CCS-
PRO without need for extra connections or software utilities.

Issues when using Free-Flow
•	 When computers and their displays are not currently selected, the CCS-PRO ‘parks’ 

their mouse pointers in the bottom right corner of the screen. In most cases this will 
cause no issues, however, it may be noticeable in circumstances such as the following: 
•	 If the task bar is set to auto hide and it is positioned either along the bottom of the 

screen (as default) or along the right hand side, then the task bar will automatically 
reappear when the mouse pointer is parked. 

•	 When playing full screen video, the on-screen controls (play, pause, seek etc.) will 
very likely be revealed when the mouse pointer is parked. 

•	 To cure the either of the above issues, it is possible to alter the mouse parking 
position.  

•	 The mouse will not flow across the screens while any mouse buttons are pressed 
down - this prevents undesired behaviour when dragging windows around or group-
selecting items.

•	 Free-Flow is not supported on Linux operating system.
•	 Multi-Monitor Free-Flow is for use with the Windows operating system only and 

requires specialist driver to be installed on each PC. See Multi-Monitor Free-Flow 
configuration for details.     More information

•	 Free-Flow configuration
•	 Multi-Monitor Free-Flow configuration
•	 Operation: Selecting a computer

As you move the mouse 
between screens, Free-Flow 

works in the background 
to switch the keyboard and 

mouse to the corresponding 
computer. 
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CCS-PRO4 FEATURES
The unit is contained within a slimline metal casing that measures just 290 x 128 x 31mm.

Indicators
The upper four indicators (K/M, SPK, USB1, USB2) show which peripherals are switched to 
the current computer channel OR (as you begin pressing the MODE button) the peripherals 

that will be switched during the next press(es) of the COMPUTER button.

The lower four indicators scroll across in sequence when the Free-Flow utility is engaged.

The seven segment numeric display indicates the computer channel that is currently active.

COMPUTER button
Press to change to the 
next computer channel. 

MODE button
Press to determine which 

peripherals should be 
switched to another 
computer channel 

(will occur when the 
COMPUTER button is 

pressed. 

Options port
IMPORTANT: Do not connect the OPTIONS port to any network.
This 10p10c port can separately support the following functions:

• Remote control - allows channel switching either using an optional Adder RC4 four button 
remote control unit (see Optional RC4 remote control) or a computer with serial port.

•	LED monitor indicators - the optional CCS-XB module links to here and provides multiple 
light up monitor indicators.  

User console
Connect a USB 

keyboard and mouse 
plus optional speakers 
to these connectors.  

(see What is True 
Emulation?).

Computer channels
Connect a USB port (v1.1 or 2.0) 
and (optionally) an audio output 
from each computer to each of 

these four channels.

Dual power inputs
In order to provide redundancy 

Switched USB ports
Optionally connect up to 
two USB devices to these 

connectors. These ports are 
switched in an enumerated 

manner.

Network port
Can be used to remotely configure the 

CCS-PRO4 and/or control switching from 
an external source, such as a Crestron™, 

AMX™ or similar controller (see 
Switching control via the network port  

for details).

Micro USB port
Reserved for future use. 
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COMPUTER K/M SPK USB1 USB2 MODE

www.adder.com
CCS-PRO8

INDOOR USE ONLY

12V 1.5A 12V 1.5A

8 47 36 25 1USER
CONSOLE

OPTIONS

DO NOT CONNECT

TO NETWORK! USB 1

USB 2

USB 2.0
SWITCHED

CCS-PRO8 FEATURES
The unit is contained within a slimline metal casing that measures just 433 x 158 x 31mm.

Indicators
The upper four indicators (K/M, SPK, USB1, USB2) show which peripherals are switched to 
the current computer channel OR (as you begin pressing the MODE button) the peripherals 

that will be switched during the next press(es) of the COMPUTER button.

The lower four indicators scroll across in sequence when the Free-Flow utility is engaged.

The seven segment numeric display indicates the computer channel that is currently active.

COMPUTER button
Press to change to the 
next computer channel. 

MODE button
Press to determine which 

peripherals should be 
switched to another 
computer channel 

(will occur when the 
COMPUTER button is 

pressed. 

Options port
IMPORTANT: Do not connect the OPTIONS port to any network.
This 10p10c port can separately support the following functions:

• Remote control - allows channel switching either using an optional Adder RC8 eight button 
remote control unit (see Optional RC4 remote control) or a computer with serial port.

•	LED monitor indicators - the optional CCS-XB module links to here and provides multiple 
light up monitor indicators.  

User console
Connect a USB 

keyboard and mouse 
plus optional speakers 
to these connectors.  

(see What is True 
Emulation?).

Computer channels
Connect a USB port (v1.1 or 2.0) 
and (optionally) an audio output 
from each computer to each of 

these eight channels.

Dual power inputs
In order to provide 

redundancy 

Switched USB ports
Optionally connect up to 
two USB devices to these 

connectors. These ports are 
switched in an enumerated 

manner.

Network port
Can be used to remotely configure the 

CCS-PRO8 and/or control switching from 
an external source, such as a Crestron™, 

AMX™ or similar controller (see 
Switching control via the network port  

for details).

Micro USB 
port

Reserved for 
future use. 
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SUPPLIED ITEMS

Information wallet 
containing:

Four self-adhesive rubber feet
Safety document

Adder CCS-PRO4

Power adapter with locking 
connector and country-
specific power cord

www.adder.com

CCS-PRO8

COMPUTER

MODE

KVM
SPK

USB1
USB2

Adder CCS-PRO8

OR
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OPTIONAL EXTRAS

Standard 3m CAT5 patch lead
Part number: VSC23

Audio cable 2m (3.5mm stereo jacks)
Part number: VSC22

www.adder.c
om

4

3

2

1

ADDER

RC4 remote control  
plus standard 3m patch lead

Part number: RC4-8P8C

USB cable 2m (type A to B)
Part number: VSC24

www.adder.com

CCS-XB

CCS-XB controller

LED monitor indicator x 4 
(or x 8)

Part number (each): CCS-LED

Four self-adhesive 
rubber feet

CATx link cable
Part number: VSC46

CCS-XB and CCS-XB8 LED monitor indicator kits
Kits are available for both switch models - the only difference between the two 
kits are the numbers of LED indicators supplied within the kit: 4 or 8.

Additional power adapter  
with locking connector

Part number: PSU-IEC-12VDC-1.5A

Serial cable
Part number: VSC40

Country-specific power cords
	 CAB-IEC-AUS	 (Austrailia)
	 CAB-IEC-EURO	 (Central Europe)
	 CAB-IEC-UK	 (United Kingdom)
	 CAB-IEC-USA	 (United States)

CCS-PRO4 rack mount brackets  
plus four screws

Part number: RMK9

2

1 4

3 6

5 8

7

RC8 remote control  
plus standard 3m patch lead

Part number: RC8

CCS-PRO8 rack mount brackets  
plus four screws

Part number: RMK11
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Installation
LOCATIONS
Please consider the following important points when planning the position of the CCS-
PRO switch:
•	 Situate the CCS-PRO switch close to the systems to which it will be connected and 

near to a source of mains power.  
•	 Thanks to Free-Flow, (and/or the optional remote control) the CCS-PRO switch can 

be situated out of sight within the cabling cradle of a desk, standard rack mount or 
placed adjacent to the connected systems.    

•	 Consult the precautions listed within the Safety information section.

MOUNTING
Before you begin connecting to the keyboard, mouse and source systems, it is advisable 
to mount the CCS-PRO switch in place, either:
•	 On a horizontal surface using the supplied self adhesive feet, 
•	 In a standard 19” rack mount (using optional brackets), or
•	 Amongst the cabling at the rear of the desk.

HT
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4	 Audio: Where required, connect the lead from your 
speakers to the audio socket.  

3	 USB devices: Where required, attach the leads from your USB 
peripherals to the USB sockets labeled USB1 and USB2.

CONNECTIONS
Connections do not need to be carried out in the order given within this guide, however, 
where possible connect the power in as a final step

User console
The ports that make up the user console are where you attach the peripherals which 
will be shared between the computer systems. Ensure that power is disconnected from 
the switch. 

To connect peripherals to the user console
1	 Position your peripheral devices in the vicinity of the switch such that their cables will 

easily reach.
2	 Keyboard and mouse: Attach the leads from your USB keyboard 

and mouse to the USB sockets specifically labelled with 
keyboard and mouse symbols. The keyboard and mouse 
will operate in any of the USB sockets, however, True 
Emulation is not available on sockets labeled USB1 
or USB2.

From speakers
From USB keyboard and mouse

From USB peripherals

Support for optical S/PDIF audio
The Line In sockets on the computer ports and 
the Line Out socket on the user console are 
dual purpose. They can accept either 3.5mm 
analog jacks or mini- TOSLINK optical fiber 
connectors. The latter provide access to the 
optical S/PDIF (Sony/Philips Digital InterFace) 
capabilities supported by the AdderView CCS-
PRO system, which switches PCM (Pulse Code 
Modulation) audio at 96KHz.
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Computer systems
Each computer system is connected to the CCS-PRO switch using (up to) two cables. 
•	 CCS-PRO switches support USB 2.0 (incl. USB 1.1) connections.

To connect a computer system
1	 Ensure that power is disconnected from the CCS-PRO4 switch and the system to be 

connected. 
2	 Use a USB cable (type-A to type-B) to link a USB port on the computer system to the 

USB port of the required channel on the rear of the switch.
3	 If required, use a stereo audio link cable (3.5mm jacks at either end) to link the 

speaker port on the computer system to the audio port of the required channel on 
the rear of the switch.

USB and audio links 
from a system
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Power connections
The CCS-PRO switch is supplied with a single power adapter but offers the facility to 
use a second input in order to provide operational redundancy. The CCS-PRO unit can 
operate perfectly well from a single power adapter operating alone. When two adapters 
are connected, the unit will spread its load between them; should one power input fail, 
100% of the load will be transferred to the other power adapter without a break in 
operation. Remote checking of the power inputs is possible at any time via the browser 
interface - see Status page for details.   
There is no on/off switch on the CCS-PRO unit, so operation begins as soon as power is 
applied at either port.

To connect the power supply
1	 Attach the output connector of the supplied power 

adapter to either of the two power input sockets 
on the left side of the rear panel.

	� Note: The outer sleeve of each power connector will retract slightly as it locks into place.
2	 Connect the IEC connector of the supplied country-specific power cord to the socket 

of the power adapter.

3	 Connect the power cord to a nearby main supply socket. 
4	 Where power redundancy is required, repeat steps 1 to 3 for a second power adapter. 

To disconnect a power adapter
1	 Isolate the power adapter from the mains supply.
	� Note: If you are replacing one of dual power adapters during operation, it is not necessary to 

also remove power from the other adapter. 
2	 Grasp the outer body of the power adapter plug where it connects with the CCS-

PRO unit.
3	 Gently pull the body of the outer plug away from the switch. As the body of the plug 

slides back, it will release from the socket and you can fully withdraw the whole plug. 

IMPORTANT: Please read and adhere to the electrical safety information 
given within the Safety information section of this guide. In particular, do not use 
an unearthed power socket or extension cable.
Note: Both the switch and its power supplies generate heat when in operation and will become 
warm to the touch. Do not enclose them or place them in locations where air cannot circulate 
to cool the equipment. Do not operate the equipment in ambient temperatures exceeding 
40 degrees Centigrade. Do not place the products in contact with equipment whose surface 
temperature exceeds 40 degrees Centigrade. 

Input 1

Input 2
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RC4 remote

Optional remote control
The optional RC4 and RC8 remote control units (part numbers: RC4-8P8C and RC8, 
respectively) can be used to provide direct push button access to any channel from your 
desktop. Both remote controls are supplied with 3 meter cables that are used to link 
with the OPTIONS port on the rear panel of the switches. 
IMPORTANT: Do not connect the OPTIONS port to any network.      

To connect the remote control
1	 Connect either end of the supplied cable to the socket at the rear of the RC4/RC8 

remote control.	

2	 Connect the other end of the cable to the OPTIONS 
port on the rear panel of the switch.

4

3

2

1

CCS-XB

Patch cable  
Adder P/N: VSC23 

(Included in RC4-8P8C kit)

Using a remote control with the optional CCS-XB module
When the optional CCS-XB LED monitor indicator module is used with the CCS-PRO 
switch, it requires permanent use of the latter’s OPTIONS port which would otherwise 
be used to attach the RC4 remote.
However, the CCS-XB module has an output port that provides a link through to the 
OPTIONS port (to which it is connected) that can be used to attach the RC4 remote.

To connect the remote control to the CCS-XB module     
1	 Use the Adder Free-Flow utility to program the CCS-PRO switch (see the section 

Configuring LED monitor indicators). 
2	 Use the patch cable supplied with the RC4/8 kit to link the remote control to the TO 

KEYPAD OR PC port of the CCS-XB module. 
	� The remote control can now be used in the usual manner to select the required 

channels.

IMPORTANT: Do not 
connect the OPTIONS 
port to any network. 

2

1 4

3 6

5 8

7

RC8 remote
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Optional LED monitor indicator connections
The optional CCS-XB module enables you to add LED (Light Emitting Diode) monitor 
indicators to each of your video display screens to show which are active.
The CCS-XB module connects to the OPTIONS port of the main CCS-PRO switch. Each 
individual LED monitor indicator then connects to one of the ten ports on the CCS-XB 
module. 

To connect the CCS-XB module and monitor indicators
1	 Remove power from the switch. Use the flat 1m cable supplied with the CCS-XB kit 

to link the module to the OPTIONS port of the CCS-PRO switch.
	� Note: If an optional RC4 or RC8 remote control is connected to the Options port, remove this 

first. It can be attached to the CCS-XB module later (see here).
	� Warning: Do not attempt to connect using a longer cable, as this is likely to 

affect performance.

2	 Link each LED monitor indicator to a port on the CCS-XB 
module - ports 1 to 4 are most commonly used.

Adder CCS-PRO 
switch

Link cable  
Adder P/N: VSC46 

(Included in CCS-XB kit)

Adder CCS-XB 
module

3	 You need to tell the CCS-PRO which LED monitor indicator to illuminate (and in 
which colour) for each channel. To do this connect your computer to the CCS-PRO 
switch via a network connection and use the Free-Flow application. Please see the 
section Configuring LED monitor indicators.

4	 Apply power to the switch.

www.add

CCS-XB

LED monitor indicator with  
3 meter lead

Port 2

Port 3

Port 4

Insert the lead for 
the first indicator 

into port 1

Each indicator has an adhesive pad to 
assist with mounting on your video 

displays. 

IMPORTANT: Do not 
connect the OPTIONS 
port to any network. 
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Switching control via the network port
The network port allows switching to be controlled by commands issued from an 
external system such as a Crestron™ or AMX™ controller.

Connecting to a network for remote control
1	 Use a standard patch cable to link the network port ( ) of the CCS-PRO unit to a 

network switch. 

Link from 
network 
switch

Issuing remote switching commands via the network port
The Application Programming Interface (API) for the CCS-PRO requires the controlling 
system to send an HTTP Get request to the following location:
•	 <ipaddress>/cgi-bin/channel

The following parameters are available:
•	 km=<channel>	 Switches the keyboard and mouse to the defined channel.
•	 spk=<channel>	 Switches the speakers to the defined channel.  
•	 usb1=<channel>	 Switches USB port 1 to the defined channel.
•	 usb2=<channel>	 Switches USB port 2 to the defined channel.

An example string is:        192.168.1.22/cgi-bin/channel?km=3&spk=4&usb1=2&usb2=1
The above example would switch the keyboard and mouse to channel 3, the speakers to 
channel 4,  USB port 1 to channel 2 and USB port 2 to channel 1.

Note: If security is enabled then the client must be authenticated before you are able to access 
the CCS-PRO. 2	 Ensure that the CCS-PRO network port is correctly configured to a subnet that is 

accessible from the sending device. See Network settings for details. 
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Switching control via the Options port
The OPTIONS port allows an external serial input, typically from a computer, to control 
the selection of the various channels. You can use either an optional serial cable (part 
number VSC40) or alternatively construct a custom cable to link the CCS-PRO switch 
and the computer. For pin-out details of the custom cable, see Appendix 1.
Upon receipt of the correct code, the CCS-PRO will switch immediately to the 
appropriate channel.

Connecting a computer for remote control
The cable link from the computer needs to connect the transmit (TXD) line of the 
computer to the receive (RXD) input of the CCS-PRO and also link the ground 
terminals (GND) of the two devices. See Appendix 1 for details.  

To connect a computer remote control
1	 Use an optional serial cable to link the OPTIONS port on the rear panel of the CCS-

PRO switch and a vacant serial port on the computer.

	� Note: If the optional CCS-XB module is used with the CCS-PRO, connect the computer instead 
to the TO KEYPAD OR PC port on the CCS-XB module.  

IMPORTANT: Do not 
connect the OPTIONS 
port to any network. 

Serial port parameter settings
Ensure that the chosen serial port is configured to the following:
•	 Baud rate: 	 1200
•	 Data bits: 	 8
•	 Stop bit: 	 1
•	 Parity:		 None 

Channel selection codes
	� 	 ASCII 

	 Character	 Hex	 Decimal
•	 Channel 1: 	 ‘1’	 0x31	 49
•	 Channel 2: 	 ‘2’	 0x32	 50
•	 Channel 3: 	 ‘3’	 0x33	 51
•	 Channel 4: 	 ‘4’	 0x34	 52
•	 Channel 5: 	 ‘5’	 0x35	 53
•	 Channel 6: 	 ‘6’	 0x36	 54
•	 Channel 7: 	 ‘7’	 0x37	 55
•	 Channel 8: 	 ‘8’	 0x38	 56

CCS-PRO8 models only
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Configuration
INITIAL CONFIGURATION
The configuration, monitoring and management of the CCS-PRO unit is performed using 
the in-built Adder CCS Manager utility which is accessible via the network connection 
using a standard web browser.

Accessing the CCS Manager
To access the CCS Manager
1	 Use a computer that is directly or indirectly (i.e. via a network switch) connected to 

the CCS-PRO unit. If you need to make a temporary connection, see right Ü 	
2	 Run a web browser on your computer and enter the IP address of the CCS-PRO. The 

default setting is: 192.168.1.22
3	 If requested, enter your username and password to log on.
	� Note: The default username and password are ‘admin’ and ‘password’ respectively.  
	� The opening page of the CCS Manager should be displayed: 

Temporary link from 
your computer

To temporarily connect a computer to the network port
1	 If you need to make a temporary connection for configuration purposes, use a 

standard patch cable (cross-over or straight connections are both supported) 
to link the Ethernet 10/100 network port ( ) of the CCS-PRO unit to your 
computer’s network port.

Logging out
There is no log out option. You merely need to close the browser that you are using to 
access the CCS Manager.

	� Note: If the CCS-PRO has been previously configured and those settings are unknown, see the 
Troubleshooting section for details about reverting to the default settings.	

HT
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Status page
The Status page provides details about the dual power inputs, the internal operating 
temperature and also allows you to switch peripheral channels. 

To display the Status page
1	 Access the CCS Manager.
2	 The Status page is the first to be displayed, however, if necessary, click the Status 

button shown on the left side: The page will be displayed: 

Channel control
The Channel control section shows the computers to which each of the user console 
peripheral channels are switched. You can use these entries to individually switch each 
peripheral to any of the computers.

To switch peripherals between channels
1	 Access the CCS Manager.
2	 If necessary, on the left side, click the Status button.
3	 In the Channel control section, click the numeric field to 

the right of the required peripheral channel, (e.g. KM channel, 
speaker channel, etc.) to reveal a drop down list.

4	 Click the number of the computer to which the peripheral 
should be switched.  The CCS-PRO front panel display will 
respond when peripheral channels are switched: 
•	 The main seven digit number shows the computer to which 

the KM (Keyboard and Mouse) channel is connected.
•	 If any of the other channels are switched to a different channel than the KM, their 

respective indicators will flash.

Provides power 
input and internal 

temperature details as 
well as the unit’s fixed 

MAC address. 

Indicates to which computer 
channels the various user console 

peripherals are currently connected. 
You can click these to switch any 
peripheral to another channel. 

Click here to 
choose the 

required page.
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General configuration
The General configuration page contains various switching and identification options.   

To display the General configuration page
1	 Access the CCS Manager.
2	 On the left side, click the Configuration button.

Basic options
Within the General configuration page you can adjust various Basic options: 

•	 Hotkeys - CCS-PRO switches use  and  as their standard hotkeys. These can 
be changed if they clash with other software or hardware within the installation (Ctrl + 
Shift, Alt + Shift, .Right Alt, etc.). 

•	 Default switching mode - Determines the standard switching mode to be used at 
power on (All, KM + speaker, KM only, etc.). 

•	 Mouse switching - You can enable or disable mouse switching to suit your 
installation requirements.

•	 Options port mode - Determines how the serial Options port should function. 
Choices are Serial control to received switching commands from a computer or RC4 (or 
RC8) compatible for use with optional Adder remote controls.    

•	 Options port speed - When the setting above is set to Serial control, this setting 
allows you to choose the communication speed (110 to 230400 baud). 

•	 Port cycling - Determines which computer ports should be visited when the user 
issues an instruction (either by mouse buttons or keyboard hotkeys + tab) to cycle to 
the next port. Options are Cycle all ports (even those that are not active) or Cycle only 
active ports.  

•	 Audio mixing - Allows you to route the audio channels from any (or all) computers 
to the user’s speakers, regardless of which computer is currently switched through to 
the user console. This is useful for hearing alerts that may be sounded by computers. 
Place a tick next to each computer whose audio you wish to route through to the 
user console at all times. 

Keep alive options
This feature is used to prevent selected computers from going into sleep mode by 
emulating activity on the mouse/keyboard. Two modes are possible:
•	 On activity - When chosen, keep alive activities are sent every 15 seconds as long as 

the local console is in use. When the local console is not in use then no keep alives are 
sent.

•	 Always - When chosen, keep alive activities are sent continuously every 15 seconds.
Channels: Place a tick next to each computer that needs to be kept awake.

Switch identification
This section allows you to optionally apply Name, Description and Location details to the 
CCS-PRO. For larger installations where multiple units exist, this information can be 
very useful for identification purposes. Additionally, the Name entry is also used when 
performing a DHCP search. 
If the Name and Location entries are set, they will be displayed at the top of each CCS 
Manager page as the Switch ID (replacing the MAC address).   
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Network settings
To display the Network settings page
1	 Access the CCS Manager.
2	 On the left side, click the Configuration button.
3	 On the left side, click the Network settings option. 

The various network settings are as follows:  
•	 Require a username and password to logon - When ticked, the unit will request 

a valid username and password before allowing access to the CCS Manager. 
•	 Obtain IP address automatically (DHCP) - When ticked, the unit will derive 

its IP address, netmask and gateway settings from the DHCP (Dynamic Host 
Configuration Protocol) server on the local network. Additionally, the optional Name 
entry entered within the General Configuration section can also be used when 
performing a DHCP search. 

•	 Address, Netmask and Gateway - When the setting above is unticked, these three 
fields are used to define the fundamental network settings of the CCS-PRO unit. The 
default settings are as follows:
•	 Address: 	 192.168.1.22
•	 Netmask:	 255.255.255.0
•	 Gateway:	 192.168.1.1

	� When the Obtain IP address... option is ticked, these three fields will display the 
settings that were defined by the DHCP server.
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User accounts
To display the User accounts page
1	 Access the CCS Manager.
2	 On the left side, click the Configuration button.
3	 On the left side, click the User accounts option. 

Managing users
The maximum number of declared users is limited to an administrator and up to four 
other users. A list of current users will be shown and you can alter the list as follows:

To edit a user
1	 Click on the user name.
2	 Click the Edit user button.
3	 Adjust the Username and/or Password as required.
	� Note: The admin username cannot be changed.
4	 Click the Save button.

To add a user
1	 Click the Add user button.
2	 Enter the required Username and/or Password.
3	 Click the Save button.

To delete a user
1	 Click on the user name.
2	 Click the Edit user button.
3	 Click the Delete user button.
	� Note: The admin user cannot be deleted.
4	 Click the Save button.
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Clipboard
To display the Clipboard page
1	 Access the CCS Manager.
2	 On the left side, click the Configuration button.
3	 On the left side, click the Clipboard option. 

Enabling clipboard operation
In order to use the USB Clipboard utility to copy and paste data between connected 
computers, the ports must be enabled individually. Before enabling a port, ensure that 
the connected computer is accessed exclusively by a single operator, ie not connected 
to multi-user or matrix KVM switches, where unintentional sharing of clipboard data is a 
possibility:

To enable clipboard operation
1	 Click on each required port number to place a tick.
2	 Click the Save button.
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Factory reset
To display the Factory reset page
1	 Access the CCS Manager.
2	 On the left side, click the Configuration button.
3	 On the left side, click the Factory reset option. 

Performing a factory reset
A factory reset will return the CCS-PRO to its original configuration. All network 
settings will be reset (the default IP address of 192.168.1.22 will be restored) and all 
users, except for the admin user will be removed. Additionally, if any Free-Flow layouts 
are stored, they will also be removed from memory.  
There are two ways to perform a factory reset:
•	 Within the Factory Reset page of the CCS Manager, or
•	 Using the front panel MODE button.
Both methods are discussed below.

To perform a factory reset within CCS Manager
1	 Within the Factory Reset page, click the Factory reset button.
	� The CCS-PRO unit will be returned to its standard state.

To perform a factory reset using the front panel MODE button
1	 Remove power from the CCS-PRO unit.
2	 Press and hold the front panel MODE button and restore power.
	� The CCS-PRO unit will be returned to its standard state.
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Upgrade
To display the Upgrade page
Note: Firmware upgrades are not possible using the Safari browser, please use a different 
browser when performing upgrades.
1	 Access the CCS Manager.
2	 On the left side, click the Upgrade button.

Performing a firmware upgrade
The CCS-PRO switch is fully upgradeable via a firmware upgrade.
Note; Once the CCS-PRO has entered upgrade mode the USB ports are disabled. It is not 
recommended to apply the upgrade from a computer connected to the CCS-PRO. If the upgrade 
file is on a memory stick connected to the CCS-PRO, The CCS-PRO will remain in this locked 
state, in order to recover you can connect to the webpage and perform the upgrade again.

To perform a firmware upgrade
1	 Download the latest CCS-PRO firmware upgrade file from the Adder Technology 

website (www.adder.com) and install it on a computer that is attached via a network 
connection to the CCS-PRO switch. 

	� The file is supplied as a compressed ZIP file. Decompress the ZIP file with an 
appropriate tool such as WinZip (www.winzip.com) and extract the contained *.bin file. 

2	 Access the Upgrade page (as detailed left).
3	 Click the Select upgrade file button and use the subsequent file dialog to locate 

the downloaded *.bin upgrade file. Once selected, the name of the upgrade file will be 
displayed within the Upgrade window.

4	 Click the Start upgrade button. As the process begins, the Upgrade page will show 
‘Upgrade in progress’ and the CCS-PRO front panel will show ‘ ’.  

	� The upgrade process may take several minutes to complete, after which time the CCS-
PRO front panel will return to showing the current channel number.  
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FREE-FLOW CONFIGURATION
Note: Whenever a factory reset is performed on a CCS-PRO unit, the Free Flow Configuration will 
be deleted and need to be repeated.

Installing the standard configuration application
The Free-Flow configuration application is available for download from the Adder 
website (www.adder.com).
1	 Install the application onto any computer (not necessarily one of the four computers 

linked to the CCS-PRO switch).
2	 Connect the computer to the CCS-PRO via the network port. See To temporarily 

connect a computer to the network port for details.
3	 Run the installation application and follow the on-screen instructions. Once installed, 

start the Free-Flow application. It may report that it is ‘Unable to communicate with 
the device’. If so:
a	 Click the OK button, whereupon the Free-Flow window will open. 
b	 Select Configure > Connection... to display the Communications configuration 

dialog. 
c	 In the first tab, select the Network connection. The Serial option is used only for 

the legacy CCS4-USB switch:

Configuring a standard Free-Flow system
Use the Free-Flow application to declare the display screens and their positions relative 
to each other. Then download the configuration to the CCS-PRO switch.
1	 On the icon bar, click the red, green, blue and yellow screen icons (or use the Screens 

menu) to add the required number of display screens to the map area:

1A 2A 3A 4A 1A 2A
3A 4A 1A

2A 3A 4A

	� Note: By default, the Free-Flow screen will automatically add four screens in a straight row  
( 1A 2A 3A 4A ), each at a resolution of 1920 x 1080. You can edit or delete these screens 
as required.

2	 Arrange the coloured rectangular screen representations to mimic the physical layout 
of the actual displays, for example: 

(Windows PC required)

d	 Enter the IP address of the CCS-PRO unit (it is set to 192.168.1.22 as standard) as 
well as the username and password, if used. 

e	 If required, test the connection. Select Configure > Send Layout to Switch. If 
no error message is returned then you can assume the connection is working.  

	� The important thing is to define where each screen edge abuts to the next so that the 
CCS-PRO switch can determine the correct moments to switch channels. 

	� Use the small black squares around the perimeter of each highlighted screen 
representation to change their size or stretch them.

	� Note:  The numbering of the screen images relate directly to the four channels on the switch.

	� continued
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3	 Double-click on each screen representation to set the screen resolution and, 
optionally, add a screen name and/or configure an LED monitor indicator: 

See also Additional Free-
Flow operations and settings

	� The screen resolutions are not critical but they enable the CCS-PRO switch to 
accurately map the movement of the mouse onto corresponding movements of the 
pointer across the screens. The screen names, if used, are not downloaded to the 
CCS-PRO switch.

	� If you need to configure an LED monitor indicator, click the LED Setup tab. Please see 
Configuring LED monitor indicators for details.

4	 When the screen map is complete and accurately matches the true layout of the 
display screens, choose File > Save to store a copy of the layout. The layout will be 
stored as a ‘Free-Flow Config file’ with the extension: .ffc

5	 To send the configuration, select Configure > Send Layout to Switch. 
•	 If the download is successful, the screen representations will briefly turn grey and 

the upper four indicators on the CCS-PRO switch will begin to scroll across (they 
will continue to do this while Free-Flow mode is enabled).

•	 If the download is unsuccessful, a message dialog will explain that it is ‘Unable to 
communicate with the device’. Check the connection and the settings mentioned in 
the section Installing the standard configuration application. 
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Multi-Monitor Free-Flow configuration
Installing multi-monitor driver and settings app
In order to use Multi-Monitor mode you will need to install a Multi-Monitor Free-Flow 
driver (available for download from the Adder website www.adder.com) onto each PC 
that has multiple monitors attached.
1	 On each multiple monitor PC, run the downloaded file. After accepting the licence 

agreement you will be prompted to choose a destination folder. Either accept the 
suggested location or change it, as necessary.

	� Note: The Install for all users option should be ticked if there are more  
than one user account on the PC and all need to use Free-Flow.

2	 The options available during installation are as follows:
•	 Full Install, (this is recommended), or
•	 Options to install individually:

•	 Configuration App  
This is the Free-Flow application and needs to be installed only on the PC that 
will be used to set up the CCS-PRO switch via the network port.

•	 Visual C++ Runtime 
The C++ runtime library is a windows component that is required by the 
multi-monitor driver in order to run its helper applications. It is pre-installed 
with Windows but is offered here as an option as you may want to keep an 
older version already installed on your system, or you may already have a newer 
version in your copy of Windows. 

•	 Drivers 
Multi-Monitor Free-Flow drivers that are required on each PC that will be using 
Multi-Monitor.   

	� Choose the required components and click the Next > button.  
3	 Once the chosen components have been installed, click the Finish button.
	� Note: On the PC that will be used to set up the CCS-PRO switch, you can optionally tick ‘Click 

to run the Free-Flow Configuration Application’ in the lower left corner to immediately begin 
using Free-Flow - see Configuring multiple monitors on the next page for details. 

	� Note: On each PC that you installed the driver, a process called mumoapp.exe will remain 
running.

(Windows only)
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Configuring multiple monitors
Multi-Monitor configuration is similar to the standard Free-Flow setup except that you 
can add more than one display per PC, up to a total of sixteen per machine.
Note: It is necessary to install a driver on each PC that has multiple displays - see Installing 
multi-monitor driver and settings app on the previous page.   
1	 If it is not already running, start the Free-Flow configuration application on the 

computer that is connected to the network port of the CCS-PRO switch. See 
Installing the standard configuration application for details.  

2	 On the icon bar, click the red, green, blue and yellow screen icons (or use the Screens 
menu) to add the required number of display screens per computer to the map area. 

	� For example, to add two monitors for PC 1, click the red computer icon twice. The 
two red monitor representations will be placed side by side within the Free-Flow map 
area.  

4	 [Optional step] If you need more squares on the grid in order to arrange many 
displays in a row, right click on an empty square (or on the darker gray edging) to 
enlarge the grid. Further right clicks will add even more empty squares.

5	 Continue from step 3 of the standard Free-Flow configuration instructions.  

Multi-Monitor Settings App
The Multi-Monitor Settings app is installed as part of the Multi-Monitor Free-Flow driver.  
The app has two functions:
•	 Display an identifier: A to P in the top left corner of each connected monitor.  These 

identifiers help you to create the Free-Flow layout in the configuration application. 
•	 Re-order displays. The order of the identifiers may differ from the Windows Display 

Manager.  Windows occasionally reorders displays, particularly on power-up, if 
more than 3 are connected. The driver organizes the identifiers using the physical 
graphics card hardware, rather than the Windows Display Manager’s layout to ensure 
consistency.

The app is installed as a Windows tray entry, identified with the icon:

Displays may also require reordering when using the CCS-PRO with a KVM matrix 
where the host computer connected to each of its ports may change and have a different 
number of connected displays.
Click the icon to display the Settings dialog:
An icon will be displayed for 
each detected monitor, labelled 
A up to P. The monitors will be 
displayed in a row, as per the 
connector layout on the video 
card.
Use the Identify button to 
display the current identifier 
on each monitor.
To reorder a monitor, right 
click on its icon and choose a 
new identifier from the drop 
list. This will switch the order of the two monitors concerned. Use the Apply button to 
activate the changes.
Use the Undo button to cancel the last edit.
The Reset to Default button to cancel all the reorder changes.

3	 Arrange the coloured rectangular screen representations to mimic the physical layout 
of the actual displays. For example, you may wish to have the two screens of PC1 side 
by side, with the two screen screens of PC2 below them (as shown left), or some 
other arrangement to reflect the actual positions of the physical monitor screens.   

	� The important thing is to define where each screen edge abuts to the next so that the 
CCS-PRO switch can determine the correct moments to switch channels. 

	� Use the small black squares around the perimeter of each highlighted screen 
representation to change their size or stretch them.

	� Note: The numbers of the screen representations relate directly to the four channels on 
the CCS-PRO switch, while the letters relate to the screen hierarchy attached to any single 
computer (i.e. A is primary, B is secondary, etc.).
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Configuring LED monitor indicators
When the optional CCS-XB LED monitor indicator kit is used, there are several 
configuration options available that allow you to customise behaviour and these are set 
using the Free-Flow configuration application.
Note that the LED monitor indicators may be used without Free-Flow.

Adjusting colour and brightness for all indicators
If necessary, you can impose default colour and brightness settings upon all connected 
LED monitor indicators. Choose Configure > LEDs... to display the following popup:

4	 Choose the CCS-XB LED output port that you wish to associate with the currently 
selected video screen.

5	 Optionally alter the colour, from the Colour: list, that you wish the LED indicator to 
display when the associated video screen is selected:

To impose a default colour on all connected indicators, choose the required Default 
colour and then tick the option Set all LEDs to this colour. 
Use the Default brightness option to determine the intensity of all indicators.
Click OK to exit and apply the required settings. 
Note: Once default settings have been made you can optionally change any or all indicators 
individually as required using the steps outlined below.    

Adjusting individual indicators
For each installed video display screen, you have the opportunity to add and configure an 
LED monitor indicator.

To adjust details for an individual indicator 
1	 Double-click on a screen representation (or right click on a screen representation and 

then choose Properties) to display the screen popup. 
2	 Click the LED Set-up tab to display the indicator details: 

3	 For a newly added screen the LED: entry will show No LED. Click on the drop 
down handle and choose the LED indicator that you wish to associate with the 
currently selected video display screen:

w
w

w
.a

d
d
e
r.c

o
m

C
C

S
-X

B

Each entry within the LED: list relates to one of 
the ten output sockets on the CCS-XB module.
Note: It is possible to associate any LED 
indicator with more than one video screen.

6	 Click OK to save and exit. 
7	 Repeat steps 1 to 6 for each screen that requires an LED monitor indicator.
8	 Choose Configure  > Send Layout to Switch to update the CCS-PRO switch.
9	 The LED monitor indicators may be used without Free-Flow. To disable Free-Flow, 

simultaneously press and hold Ctrl and Alt, then press F. This acts as a toggle, so repeat 
to re-enable Free-Flow.

Note: Each LED indicator can only 
have one colour, so if you associate an 
indicator with more than one screen 
and then change the colour on a later 
screen assignment, it will be changed 
for all the screens in the list for that 
LED indicator.
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Additional Free-Flow operations and settings
In addition to the core configuration functions, Free-Flow has a number of additional 
settings that you can make.  

Mouse... (acceleration) setting 

Acceleration
Mouse acceleration allows you to move the mouse pointer quickly across the large areas 
of the screen in response to small but sharp shifts in the mouse position. The Configure 
> Mouse... option provides settings between 0 and 50, however, a value of 12 to 15 will 
give a typical Windows-like default operation. 

Mouse parking... setting

Mouse parking allows you to optionally determine where the mouse pointer for each 
system should be placed when the focus moves to a different system/video screen. The 
Configure > Mouse parking... option displays vertical and horizontal scroll bars. Use 
the scroll bars to pinpoint the position that should be used to park the dormant mouse 
on each screen.

Switch... settings

Enable (Disable) Free-Flow
This option allows you to switch off the Free-Flow feature within the CCS-PRO switch. 
Located within Configure > Switch... menu item, untick the Enable Free-Flow 
checkbox and download the configuration the CCS-PRO switch to disable. 

Start-up Port
Located within Configure > Switch... menu item (see above image), this option allows 
you to determine which port should be enabled whenever the CCS-PRO switch is first 
powered on.

Switch Mode
Located within Configure > Switch... menu item (see above image), these check boxes 
allow you to determine which peripherals should be switched whenever the channel is 
changed by the Free-Flow method. The switching of peripherals via the other methods of 
channels selection (e.g. the front panel, hotkeys, mouse buttons, etc.) remain unaffected 
by these settings. By default, the Keyboard/Mouse and Audio are selected. 
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Prerequisites 
•	 The Clipboard utility is required to allow cut, copy and paste functions between 

computers. 
•	 The Clipboard utility is supported on the following operating systems: Windows 7, 8 

and 10. 
•	 Each system connected to the CCS-PRO switch requires the Adder Clipboard utility 

to be installed and activated. 
•	 Each system also requires the Microsoft .NET Framework (v4.0 or above) to be 

installed. This is available for free download from Microsoft. 
•	 The CCS-PRO switch needs to be configured to enable transfer of clipboard data. 

Refer to CCS Manager on page 21.
•	 Only text (formatted or otherwise) can be transferred between systems, to a 

maximum size of 200KB.

Security
As text is transferred between the systems attached to the CCS-PRO switch, security 
is an issue which needs to be addressed. The USB Clipboard application provides the 
option to encrypt all information. Unless the whole CCS-PRO installation is operating 
within a secure environment, you are strongly recommended to accept the use of 
encryption. When enabled, you will be given the choice of using a default encryption key 
or creating a custom one, which must be the same on every system. When creating your 
own encryption key, we recommend that it is a minimum of 8 characters, consisting of 
mixed upper and lower case letters plus at least one number and also a special character. 

Installation and configuration
•	 The USB Clipboard installer is available for download directly from Adder Technology 

(www.adder.com).

On each computer attached to the CCS-PRO switch:
1	 Ensure that you have Administrator privilege, then run the ‘Install USB Clipboard’ file.
2	 In the opening dialog, click the Install button. Follow the on-screen prompts as the 

installation progresses.
3	 At the end of the installation process, you will need to configure the application. 

Either, ensure that the ‘Configure USB Clipboard Now’ option is ticked on the final 
installation page, or finish the installation and then search within the Windows Start 
menu for ‘USBC-Config’.

4	 The initial option within the 
configuration utility relates 
to the important subject of 
security:
•	 Choose the ‘Use 

Encryption’ option unless 
the whole installation is 
fully secure. See Security 
on the left. 

5	 Click Next to continue.

INSTALLING AND CONFIGURING THE USB CLIPBOARD UTILITY

6	 If the ‘Use Encryption’ 
option was chosen, the next 
page will concern the use 
of encryption passwords. 
The same password needs 
to be used on each system 
connected to the switch. 
Choose the option that suits 
your installation. See Security 
on the left.
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7	 Click Next to continue.
	� The Options page will be displayed:

Using USB Clipboard
For details about using the USB Clipboard function, 
see page 35.

8	 Here you can: 
•	 Determine the maximum copy size (currently fixed at 200KB).
•	 Choose to show notifications - if selected, USB Clipboard will show any necessary 

messages, (such as when text is sent or received, or the clipboard capacity is being 
exceeded), as push notifications.

•	 Choose to include formatting along with text - if selected, formatting data (such as 
HTML or RTF) will be transferred across the clipboard to receiving systems. The 
necessary formatting data will form part of the 200KB maximum and will reduce 
the space available for text.

9	 Click Next to continue.
	� The Copy Delay Configuration page will be displayed:

	� The Copy Delay Configuration page allows you to insert a delay before the clipboard 
contents are copied to the target computer. The slider control allows you to configure 
the delay in 100ms increments up to a maximum of 2000ms. The default is 0ms.

	� Copy Delay is useful for integrating with, for example, call handling systems, such as 
VESTA.

10	 If necessary, change the Delay Time and then click Next to continue.
	� A summary page will be displayed:

11	 If all is correct, click Confirm to continue, otherwise use the Back button to return to 
previous pages.
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Operation
SELECTING A COMPUTER
There are six ways to switch the common peripherals to specific computer channels:
•	 Using the innovative Free-Flow automatic switching utility Þ 
•	 Using the control panel   
•	 Using hotkeys 
•	 Using mouse button presses 
•	 Remote control via an external system
•	 Using the optional RC4 remote control

Selecting a computer using the control panel
The control panel allows you to determine how the various peripherals are switched to 
one or more computer channels. 

1	 Optional: If you need to selectively switch some of your peripherals, press the MODE 
button repeatedly to change the switching mode:

Will switch all peripherals together

Will switch keyboard, mouse and speakers

Will switch only the keyboard and mouse

Will switch only the speakers

Will switch only USB peripheral 1

Will switch only USB peripheral 2

	� Notes: 
•	 If an indicator flashes, it signifies that the respective peripheral is currently switched to 

another computer channel.
•	 The peripherals to be switched using the Free-Flow method are set independently.   

2	 Press the COMPUTER button repeatedly to select the required computer channel. 

Selecting a computer using the Free-Flow utility
Once configured, Free-Flow allows you to change channels merely by moving the mouse 
to edge of one screen towards the next screen. As the mouse pointer reaches the edge 
it will cause the channel to automatically change and will jump to the next screen.
Notes: 
•	 Free-Flow cannot be enabled until a layout has been configured and downloaded to the CCS-

PRO switch - see Free-Flow configuration.
•	 The mouse will not flow across the screens while any mouse buttons are pressed down - this 

prevents undesired behaviour when dragging windows around or group-selecting items.
•	 You can determine which peripherals will be switched by Free-Flow independently of those 

that would be switched with any other method. See Switch Mode within the Switch... 
settings section.  

•	 You can continue to use any of the other channel switching methods while Free-Flow is 
enabled. 

The four upper indicators on the CCS-PRO display panel will scroll across every few 
seconds to show that Free-Flow is enabled. See What is Free-Flow? for an introduction 
to the utility or Free-Flow configuration for more details about how to prepare it for 
operation.

You can temporarily disable (and re-enable) Free-Flow using hotkey presses:

•	 Simultaneously press and hold  and , then press     

Use this button 
to choose which 
peripherals will 
be switched

The upper K/M, SPK, USB1, and USB2 indicators show which 
peripherals are switched to the current computer channel OR (as 
you begin pressing the MODE button) the peripherals that will be 
switched during the next press(es) of the COMPUTER button. 

Use this button to 
choose the next 
required computer

Indicates the number 
of the currently 
selected computer

The lower four indicators will 
intermittently scroll across 
whenever Free-Flow is enabled. 

HT
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Selecting a computer using hotkeys
Using hotkey combinations, you can quickly switch the keyboard and mouse, speakers 
and USB peripherals to any computer channel.

To select a computer using hotkeys
The standard hotkey press combinations allow you to change channels with the minimum 
of keypresses: 

1	 Simultaneously press and hold  and  (or other hotkeys, if altered). 

2	 While still holding  and , press the number key of the required channel address 
(or the TAB key), then release all of the keys. 

	� Note: The numbers on your keyboard’s numeric keypad are not valid, use only the numeral 
keys above the QWERTY section.

	� The ports (K/M, audio and/or USB) that are switched using this method depend upon 
the switching mode that is currently set using the control panel buttons.  

The range of standard hotkey combinations are as follows:

Note: If your hotkeys have been changed, substitute them for  and  in the examples 
given here. 

	�   	 Selects channel 1

	�   	 Selects channel 2

	�   	 Selects channel 3

	�   	 Selects channel 4

	�   	 Selects channel 5

	�   	 Selects channel 6

	�   	 Selects channel 7

	�   	 Selects channel 8

	�   	 Isolates the user console from all channels

	�   	 Selects the next channel (see note )

To disable/enable Free-Flow
Once Free-Flow is in operation, you can temporarily disable (and re-enable) it. You can 
tell when Free-Flow is in operation when the four lower indicators on the CCS-PRO 
front panel scroll across every few seconds.

•	 Simultaneously press and hold  and , then press    

Choosing which computers are accessed when using hot keys + tab
The computer channels that are visited when you use the hot keys + tab (or mouse 
buttons) are determined by a setting within the Configuration menu: 
1	 Enter the General configuration page of the CCS Manager. 
2	 Choose the required Port cycling option, either: 

•	 Cycle all ports (visits even inactive ports), or
•	 Cycle only active ports.

3	 Click the Save button.

What are hotkeys?
The  and  keys when pressed in combination are called ‘hotkeys’ and they 
signal to the CCS-PRO switch that you wish to control it, rather than the computer. 
However, if these particular hotkeys clash with another device or program, you can 
change them to a different combination within the General configuration page of the 
CCS Manager.

CCS-PRO8 models only
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Selecting a computer using the mouse buttons
Using the mouse buttons, you can quickly switch the keyboard and mouse, speakers and/
or USB peripherals to any computer channel.
Note: These procedures work only with three-button or IntelliMouse devices and only if the 
‘Mouse switching’ option has been enabled (within the General configuration page of the CCS 
Manager). 

To select a computer using the mouse buttons
1	 Hold down the middle button (or scroll wheel) of the mouse.
2	 Click the left mouse button to increment the channel number or click the right mouse 

button to decrement the channel. When the correct channel is reached, release the 
middle button. 

	� When using this method of switching:
•	 The computer channels that are visited depend upon the configuration menu 

setting (see note ).
•	 The ports (K/M, audio and/or USB) that are switched using this method depend 

upon the switching mode that is currently set using the control panel buttons. 

Choosing which computers are accessed when using mouse buttons
The computer channels that are visited when you use the hot keys + tab (or mouse 
buttons) are determined by a setting within the Configuration menu: 
1	 Enter the General configuration page of the CCS Manager. 
2	 Choose the required Port cycling option, either: 

•	 Cycle all ports (visits even inactive ports), or
•	 Cycle only active ports.

3	 Click the Save button.
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USING COPY AND PASTE
USB Clipboard is an optional utility which allows text to be copied and pasted between 
any of the connected systems. For installation details, see page 30.

Startup
During installation the USB Clipboard utility is added to the Windows System Tray and 
will be started automatically at every reboot.  
You will see this icon in the System Tray: 

If the USB Clipboard utility is not already running on a system, activate it using the 
Desktop shortcut ‘Start USB Clipboard’.
Notes: 
•	 The systems should be connected to the CCS-PRO switch before starting the USB Clipboard 

application. A warning message will be displayed if the CCS-PRO switch cannot be located.
•	 If the CCS-PRO switch is disconnected and reconnected on same port, the USB Clipboard 

utility will detect it automatically. If reconnected on different port then USB Clipboard utility 
will need to be restarted.

Sharing text via the USB Clipboard
The USB Clipboard is transparent in operation and essentially operates in the same way 
as a standard copy/paste procedure on any Windows system. When the USB Clipboard 
utility is running, any normal copy and paste action (of text) will be mirrored in the 
background by the utility. 

To cut/copy text
•	 On your chosen source computer, highlight the required text within any application 

and use either the menu option ‘Edit > Cut’ (or ‘Edit > Copy’), or use the keyboard 
shortcut ‘Ctrl’ + ‘X’ (or ‘Ctrl’ + ‘C’) to save a copy into the clipboard.

To paste text
•	 On your chosen destination computer, place the cursor at the required location and 

use either menu option ‘Edit > Paste’ or use the keyboard shortcut ‘Ctrl’ + ‘V’ to paste 
the clipboard contents.

Notes: 
•	 Status messages detailing the clipboard contents and operations will be displayed if the ‘Show 

notifications’ option is ticked within the configuration utility.
•	 HTML or RTF text formatting is transferable via the USB Clipboard. Ensure that the ‘Include 

text formatting’ option is ticked within the configuration utility.  

Warning and error icons
The utility will show status icons within the System Tray if issues are detected:  

Modify configuration
You can modify various operational details of the USB Clipboard utility on any of the 
connected systems.

To modify configuration
1	 Display the configuration window, either:

•	 Show the Windows System Tray: Click the ^ icon on the Windows taskbar and then 
click USB Clipboard icon to show a popup menu. Choose the ‘Configure’ option 
from the popup menu.

•	 Click the Windows Start menu, then locate and run the ‘USBC-Config’ option. 
2	 Make the required changes within the configuration window and click the Save button. 

Warning - Displayed if a 
device is not found, copy size 
is larger than limit, etc. 

Error - Displayed if a fatal error 
is detected, such as a failure to 
send or receive data.
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This chapter contains a variety of information, including the following:
•	 Getting assistance - see right
•	 Troubleshooting
•	 Appendix 1 - Cable pin-outs
•	 Appendix 2 - What is True Emulation?

GETTING ASSISTANCE
If you are still experiencing problems after checking the information contained within this 
guide, then please refer to the Support section of our website:

www.adder.com

Further information

LITHIUM BATTERY
CAUTION: This product contains a lithium battery which must be disposed 
of in the correct manner.
CAUTION: RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT 
TYPE.
•	 If the lithium battery needs to be changed, you must return the product to your 

nearest Adder dealer. The battery must be replaced by an authorized Adder dealer. 
•	 Once the product has come to the end of its useful life, the lithium battery must be 

removed as part of the decommissioning process and recycled in strict accordance 
with the regulations stipulated by your local authority. Advice on battery removal can 
be provided on request by Adder. 

HT
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TROUBLESHOOTING
Problem: My computer and the CCS-PRO switch are connected to the same 
network but I can’t make contact using a web browser. 
There may be another device using the same address as the CCS-PRO default 
(192.168.1.22) or your computer may be on a different subnet.  
Remedies: 
•	 Check whether any other device on your immediate network is using the same 

address and temporarily disconnect it, if possible. 
•	 Make a temporary direct connection between your computer and the switch in order 

to change the IP address used by the switch.
•	 Check that your computer and the switch are on the same subnet. If necessary, change 

your computer’s subnet mask setting to encompass that of the switch, e.g. instead of 
255.255.255.0, try 255.255.0.0.
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APPENDIX 1 - CABLE PIN-OUTS
The OPTIONS port uses a 10p10c socket which can accommodate both 10p10c 
connectors as well as the much more common 8p8c connectors, which are used on 
Ethernet leads and patch cables. The pin-outs are listed in this section for both types of 
connector. 

Serial remote control cable (8p8c)

Serial remote control cable (10p10c)

8p8c  
connector

D-Type female 
9 way 

6 2TXD RXD

3

2

3

5

RXD

GND

TXD

GND

10p10c  
connector

D-Type female 
9 way 

7 2TXD RXD

4

3

3

5

RXD

GND

TXD

GND

Note: You can also use the optional serial cable (part number VSC40). 
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APPENDIX 2 - WHAT IS TRUE EMULATION?
True Emulation represents a significant breakthrough in sharing USB devices between 
two or more computer systems. Until this point, the problem has been how to create a 
USB switch that provides all of the following:
•	 Quick, transparent and reliable switching,
•	 Accurate representation of the connected USB keyboard and mouse, 
•	 Switching control via the connected USB keyboard and/or mouse.
The difficulty in achieving all of the above requirements has been due to the complexity 
of the USB standard. This has led to various problems that have spawned a number of 
possible solutions.  

Enumerated USB switching
The earliest attempts to switch USB devices applied a relatively ‘hands off ’ approach. 
Enumerated USB switches are the electronic equivalent of those old mechanical KVM 
switches with a large knob on the front. 
Enumerated switches are so called because a connected USB device will be required to 
perform a full initiation (a process called Enumeration) every time it is switched; just as if 
you had pulled out the plug and then reconnected it. 
Enumerated switches simply pass all signals straight through between the USB device and 
the computer, they do not attempt to interpret any data. For most devices, this offers 
an advantage because the switch just leaves them to get on with their jobs without any 
interference or any hit on performance. However, it means that a USB keyboard or 
mouse cannot be used to control the switching process - a quick and simple control 
method expected by most users. Reliability of switching is also an issue that has plagued 
enumerated switches, especially when used with certain USB devices and particular 
operating systems. 

Emulated USB switching
The issues with interpreting the complex USB data streams and recreating (or Emulating) 
the identity of attached USB devices were eventually solved, leading to the creation of 
the Emulated USB switch. 
A neat side effect of the technique used is that each computer can be fooled into 
thinking that the USB device is permanently connected to it, even when the device is 
switched to another computer. This means that the enumeration process for the USB 
device takes place only once, during the first power on. After that, a computer merely 
sees a dormant version of the USB device whenever the device is actually connected to a 
different computer.    
However, it remains a complex task to dynamically assume the identity of a USB device, 
distribute it among the connected computers and maintain all of the necessary signals, 
states and processes. Therefore, manufacturers have previously relied upon a fixed 
keyboard and mouse profile that is declared to each computer, regardless of the actual 
connected devices. This precluded the use of any special keyboard or mouse features 
over and above the standard layouts. 

True Emulation 
Mindful of the limitations associated with the previous 
USB switching techniques, we set about creating a 
more effective and elegant solution. After a great deal of 
research and development, True Emulation is the result.
True Emulation allows the complete identity of the 
keyboard and mouse to be copied and then presented 
to all of the connected computers. This means that 
any keyboard offering specialist function keys or any 
mouse with extra features will be fully supported at 
each computer. As with the previous emulation method, 
the unselected computers will continue to see the 
identities of the keyboard and mouse, which means that 
no enumeration is necessary when their link becomes 
active once again. This not only helps to speed up the 
rate of re-connection, but also raises the reliability 
of switching because USB links are at their most 
vulnerable during the enumeration process.
True Emulation relies upon a high speed circuit, called 
an Emulation Engine, to fully emulate the USB device 
identities and also interpret keyboard and mouse data 
streams. The result is full support for K/M switching 
control via hotkey presses or the third button/scroll 
wheel of a mouse.   
True Emulation is not necessarily required by other 
USB devices, which is why you will also find two 
enumerated circuits included (shown in green within 
the block diagram) alongside the True Emulation feature 
(shown in blue). This allows those other USB devices to operate at their highest speeds, 
without any intervention. The enumerated circuits benefit greatly from the USB Hubs 
that are jointly used with the True Emulation system. Because they interface directly and 
permanently with each computer, they help to stabilise the dormant links, making errors 
during enumeration much less likely.
The dual switching arrangement provides further flexibility because the True Emulation 
and enumerated sections can be switched in unison or independently of each other, as 
required. Thus, your various peripherals can operate with different computers at the 
same time. Please see software release notes for a list of supported products.  

HOST
CONTROLLER

USB
KEYBOARD

OTHER USB
DEVICE

USB
MOUSE

USB
HUB

PC
1

PC
2

PC
3

PC
4

USB
HUB

USB
HUB

USB
HUB

EMULATION
ENGINE

The emulated section of the 
switch is shown in blue and 

handles only the keyboard and 
mouse. The green enumerated 
section of the switch handles 

other USB devices and also uses 
the USB hubs to link with the 

computers. 
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APPENDIX 3 - OPEN SOURCE LICENCES
This product includes binaries that are derived from the open source community. 
======
lwIP is licenced under the BSD licence:  
Copyright (c) 2001-2004 Swedish Institute of Computer Science.  
All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
1	 Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 
2	 Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3	 The name of the author may not be used to endorse or promote products derived 
from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Bouncycastle Cryptography
Copyright (c) 2000 - 2021 The Legion of the Bouncy Castle Inc. (https://www.
bouncycastle.org)
Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER 
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF 
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS 
IN THE SOFTWARE.
NSIS Install System
Applicable licenses
•  All NSIS source code, plug-ins, documentation, examples, header files and graphics, with 
the exception of the compression modules and where otherwise noted, are licensed 
under the zlib/libpng license.
•  The zlib compression module for NSIS is licensed under the zlib/libpng license.
•  The bzip2 compression module for NSIS is licensed under the bzip2 license.
•  The lzma compression module for NSIS is licensed under the Common Public License 
version 1.0.
zlib/libpng license
This software is provided ‘as-is’, without any express or implied warranty. In no event will 
the authors be held liable for any damages arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the following 
restrictions:
1.     The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment in 
the product documentation would be appreciated but is not required.
2.     Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.
3.     This notice may not be removed or altered from any source distribution.
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bzip2 license
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:
1.     Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.
2.     The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment in 
the product documentation would be appreciated but is not required.
3.     Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.
4.     The name of the author may not be used to endorse or promote products derived 
from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Julian Seward, Cambridge, UK.
jseward@acm.org
Common Public License version 1.0
THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS 
COMMON PUBLIC LICENSE (“AGREEMENT”). ANY USE, REPRODUCTION OR 
DISTRIBUTION OF THE PROGRAM CONSTITUTES RECIPIENT’S ACCEPTANCE OF 
THIS AGREEMENT.
1. DEFINITIONS
“Contribution” means:
a) in the case of the initial Contributor, the initial code and documentation distributed 
under this Agreement, and b) in the case of each subsequent Contributor:
i) changes to the Program, and
ii) additions to the Program;
where such changes and/or additions to the Program originate from and are distributed 
by that particular Contributor. A Contribution ‘originates’ from a Contributor if it was 
added to the Program by such Contributor itself or anyone acting on such Contributor’s 
behalf. Contributions do not include additions to the Program which: (i) are separate 
modules of software distributed in conjunction with the Program under their own 

license agreement, and (ii) are not derivative works of the Program.
“Contributor” means any person or entity that distributes the Program.
“Licensed Patents “ mean patent claims licensable by a Contributor which are necessarily 
infringed by the use or sale of its Contribution alone or when combined with the 
Program.
“Program” means the Contributions distributed in accordance with this Agreement.
“Recipient” means anyone who receives the Program under this Agreement, including all 
Contributors.
2. GRANT OF RIGHTS
a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a 
non-exclusive, worldwide, royalty-free copyright license to reproduce, prepare derivative 
works of, publicly display, publicly perform, distribute and sublicense the Contribution of 
such Contributor, if any, and such derivative works, in source code and object code form.
b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient 
a non-exclusive, worldwide, royalty-free patent license under Licensed Patents to 
make, use, sell, offer to sell, import and otherwise transfer the Contribution of such 
Contributor, if any, in source code and object code form. This patent license shall apply 
to the combination of the Contribution and the Program if, at the time the Contribution 
is added by the Contributor, such addition of the Contribution causes such combination 
to be covered by the Licensed Patents. The patent license shall not apply to any other 
combinations which include the Contribution. No hardware per se is licensed hereunder.
c) Recipient understands that although each Contributor grants the licenses to its 
Contributions set forth herein, no assurances are provided by any Contributor that the 
Program does not infringe the patent or other intellectual property rights of any other 
entity. Each Contributor disclaims any liability to Recipient for claims brought by any 
other entity based on infringement of intellectual property rights or otherwise. As a 
condition to exercising the rights and licenses granted hereunder, each Recipient hereby 
assumes sole responsibility to secure any other intellectual property rights needed, if any. 
For example, if a third party patent license is required to allow Recipient to distribute 
the Program, it is Recipient’s responsibility to acquire that license before distributing the 
Program.
d) Each Contributor represents that to its knowledge it has sufficient copyright rights in 
its Contribution, if any, to grant the copyright license set forth in this Agreement.
3. REQUIREMENTS
A Contributor may choose to distribute the Program in object code form under its own 
license agreement, provided that:
a) it complies with the terms and conditions of this Agreement; and
b) its license agreement:
i) effectively disclaims on behalf of all Contributors all warranties and conditions, express 
and implied, including warranties or conditions of title and non-infringement, and implied 
warranties or conditions of merchantability and fitness for a particular purpose;



42

IN
ST

A
LL

AT
IO

N
C

O
N

FI
G

U
R

AT
IO

N
O

PE
R

AT
IO

N
FU

RT
H

E
R

IN
FO

R
M

A
T

IO
N

IN
D

EX

ii) effectively excludes on behalf of all Contributors all liability for damages, including 
direct, indirect, special, incidental and consequential damages, such as lost profits;
iii) states that any provisions which differ from this Agreement are offered by that 
Contributor alone and not by any other party; and
iv) states that source code for the Program is available from such Contributor, and 
informs licensees how to obtain it in a reasonable manner on or through a medium 
customarily used for software exchange.
When the Program is made available in source code form:
a) it must be made available under this Agreement; and
b) a copy of this Agreement must be included with each copy of the Program.
Contributors may not remove or alter any copyright notices contained within the 
Program.
Each Contributor must identify itself as the originator of its Contribution, if any, in a 
manner that reasonably allows subsequent Recipients to identify the originator of the 
Contribution.
4. COMMERCIAL DISTRIBUTION
Commercial distributors of software may accept certain responsibilities with respect 
to end users, business partners and the like. While this license is intended to facilitate 
the commercial use of the Program, the Contributor who includes the Program in a 
commercial product offering should do so in a manner which does not create potential 
liability for other Contributors. Therefore, if a Contributor includes the Program in a 
commercial product offering, such Contributor (“Commercial Contributor”) hereby 
agrees to defend and indemnify every other Contributor (“Indemnified Contributor”) 
against any losses, damages and costs (collectively “Losses”) arising from claims, lawsuits 
and other legal actions brought by a third party against the Indemnified Contributor 
to the extent caused by the acts or omissions of such Commercial Contributor in 
connection with its distribution of the Program in a commercial product offering. The 
obligations in this section do not apply to any claims or Losses relating to any actual or 
alleged intellectual property infringement. In order to qualify, an Indemnified Contributor 
must: a) promptly notify the Commercial Contributor in writing of such claim, and b) 
allow the Commercial Contributor to control, and cooperate with the Commercial 
Contributor in, the defense and any related settlement negotiations. The Indemnified 
Contributor may participate in any such claim at its own expense.
For example, a Contributor might include the Program in a commercial product offering, 
Product X. That Contributor is then a Commercial Contributor. If that Commercial 
Contributor then makes performance claims, or offers warranties related to Product 
X, those performance claims and warranties are such Commercial Contributor’s 
responsibility alone. Under this section, the Commercial Contributor would have to 
defend claims against the other Contributors related to those performance claims and 
warranties, and if a court requires any other Contributor to pay any damages as a result, 
the Commercial Contributor must pay those damages.

5. NO WARRANTY
EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS 
PROVIDED ON AN “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, 
ANY WARRANTIES OR CONDITIONS OF TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each Recipient 
is solely responsible for determining the appropriateness of using and distributing the 
Program and assumes all risks associated with its exercise of rights under this Agreement, 
including but not limited to the risks and costs of program errors, compliance with 
applicable laws, damage to or loss of data, programs or equipment, and unavailability or 
interruption of operations.
6. DISCLAIMER OF LIABILITY
EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT 
NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY 
RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.
7. GENERAL
If any provision of this Agreement is invalid or unenforceable under applicable law, it shall 
not affect the validity or enforceability of the remainder of the terms of this Agreement, 
and without further action by the parties hereto, such provision shall be reformed to the 
minimum extent necessary to make such provision valid and enforceable.
If Recipient institutes patent litigation against a Contributor with respect to a patent 
applicable to software (including a cross-claim or counterclaim in a lawsuit), then any 
patent licenses granted by that Contributor to such Recipient under this Agreement shall 
terminate as of the date such litigation is filed. In addition, if Recipient institutes patent 
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging 
that the Program itself (excluding combinations of the Program with other software or 
hardware) infringes such Recipient’s patent(s), then such Recipient’s rights granted under 
Section 2(b) shall terminate as of the date such litigation is filed.
All Recipient’s rights under this Agreement shall terminate if it fails to comply with any 
of the material terms or conditions of this Agreement and does not cure such failure in a 
reasonable period of time after becoming aware of such noncompliance. If all Recipient’s 
rights under this Agreement terminate, Recipient agrees to cease use and distribution of 
the Program as soon as reasonably practicable. However, Recipient’s obligations under 
this Agreement and any licenses granted by Recipient relating to the Program shall 
continue and survive.
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Everyone is permitted to copy and distribute copies of this Agreement, but in order 
to avoid inconsistency the Agreement is copyrighted and may only be modified in the 
following manner. The Agreement Steward reserves the right to publish new versions 
(including revisions) of this Agreement from time to time. No one other than the 
Agreement Steward has the right to modify this Agreement. IBM is the initial Agreement 
Steward. IBM may assign the responsibility to serve as the Agreement Steward to a 
suitable separate entity. Each new version of the Agreement will be given a distinguishing 
version number. The Program (including Contributions) may always be distributed 
subject to the version of the Agreement under which it was received. In addition, after 
a new version of the Agreement is published, Contributor may elect to distribute the 
Program (including its Contributions) under the new version. Except as expressly stated 
in Sections 2(a) and 2(b) above, Recipient receives no rights or licenses to the intellectual 
property of any Contributor under this Agreement, whether expressly, by implication, 
estoppel or otherwise. All rights in the Program not expressly granted under this 
Agreement are reserved.
This Agreement is governed by the laws of the State of New York and the intellectual 
property laws of the United States of America. No party to this Agreement will bring a 
legal action under this Agreement more than one year after the cause of action arose. 
Each party waives its rights to a jury trial in any resulting litigation.
Special exception for LZMA compression module
Igor Pavlov and Amir Szekely, the authors of the LZMA compression module for NSIS, 
expressly permit you to statically or dynamically link your code (or bind by name) to the 
files from the LZMA compression module for NSIS without subjecting your linked code 
to the terms of the Common Public license version 1.0. Any modifications or additions 
to files from the LZMA compression module for NSIS, however, are subject to the terms 
of the Common Public License version 1.0.
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